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Introduction

1 Introduction

1.1 Avudience

AEMO provides this information as a service targeting business analysts and IT staff in
Registered Participant companies.

The primary audience are:
e Procurers: AEMO or Transmission Network Service Providers (TNSPs) procuring

contracts from the system security service provider.

e Providers: are parties entering into system security contracts with Procurers. Initially,
AEMO anticipates providers to be Market Generators (Scheduled and Semi-Scheduled)
and Integrated Resource Providers with Battery Energy Storage Systems (BESS).

1.2 Objective

The EMMS - Technical Specification - December 2025 (Release) describes the projects
planned by AEMO from a participant perspective and includes any system related changes for
participants.

1.3 Status
Version Status
1.00 Updated version based on the updated requirements and design. We still expect changes to the

design while development and testing are in progress.

v0.01

I \
T
— Initial Draft for review. The design is not ready for participants’ builds

Presents the EMMS - Technical Specification - December 2025 evolving design.

Please send feedback to Contact Us. In the Details of your enquiry section, mention the EAS
Knowledge Management team as the Resolver group.

© AEMO 2025 | EMMS - Technical Specification - December 2025
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1.4 Release dates

Scheduled for implementation in:

e Pre-production: Tuesday 30 September 2025

e Production:

Tuesday 2 December 2025

1.5 Projects and enhancements

Changes and enhancements for this Release include:

No. Functionality

Change

Affected Reference
interface

1 Registration

Minor updates to identify security service providers and

associated units

2 Settlements

Updates to Settlement Reports

3 Electricity Data
Model 5.6

New/updated data model tables to support enablement
instructions, ISF schedules and ISF reporting.

Settlements/Billing changes for NSCAS and NMAS

security services procured by AEMO

4 Markets Portal

New ISF interface called the Security Service

Management (SSM)

5 Reports

Adds new reports

1.6 Rule and procedure changes

The following rules and procedures take precedence over technical specifications and

guides.
Title Project Version/status  Effective
Improving security frameworks for the energy ISF Final 2 December 2025
transition
Procedures For Issue of Directions And Clause 4.8.9 ISF Final 4 July 2024
Instructions
Inertia Requirements MethOdOIOgy ISF Final 1 December 2024
Network Support and Control Ancillary Services ISF Final 1 December 2024

(NSCAS) Description and Quantity Procedure

© AEMO 2025 | EMMS - Technical Specification - December 2025
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Title Project Version/status Effective
Transitional Services Guideline ISF Final 8 November 2024
Regional Benefit Ancillary Services Procedures ISF Final 17 October 2024
(Procedures)

Provisional Security Enablement Procedures ISF Final 30 June 2024
(Provisional Procedures)

Schedule of constraint violation penalty factors ISF In-progress 2 December 2025
SO_OP_3704 Pre-Dispatch ISF In-progress 2 December 2025
Spot Market Operations Timetable ISF In-progress 2 December 2025
SO_OP_3705 Dispatch ISF In-progress 2 December 2025
SO_OP_3720 Security Enablement Procedure ISF In-progress 31 August 2025
(Complete Publication)

SO_0P3708 Non-market Ancillary Services ISF In-progress 2 December 2025
Transition plan for system security ISF Final 2 December 2024
Constraint Formulation Guidelines ISF In-progress 2 December 2025
SO_OP_3718 Outage Assessment ISF In-progress 2 December 2025

1.7 Related technical specifications

Title Description
EMMS - Technical Specification — Data Model 5.6 - November Provides the detailed Data model table
2025 changes.

1.8 Related documents

Once published, these resources take precedence over this technical specification

These guides and resources are updated according to this technical specification and
published for the pre-production Release Date.

Title Description Status

- Guide to MSATS Reports
- Security Service Management Interface

Markets Portal Help Not started

Data Interchange Online Help Update documentation related to Data Model 5.6 Not started
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https://aemo.com.au/-/media/files/electricity/nem/security_and_reliability/power_system_ops/procedures/so_op_3720---provisional-security-enablement-procedure.pdf?la=en
https://aemo.com.au/consultations/current-and-closed-consultations/isf-consultation-of-constraint-formulation-guidelines
https://aemo.com.au/-/media/files/stakeholder_consultation/consultations/nem-consultations/2019/dispatch-predispatch-procedures-spot-market/so_op_3704-predispatch-clean.pdf?la=en&hash=EEFB977B440174EDD20C72A06C3DAE96
https://aemo.com.au/consultations/current-and-closed-consultations/spot-market-operations-timetable
https://aemo.com.au/-/media/files/stakeholder_consultation/consultations/nem-consultations/2019/dispatch-predispatch-procedures-spot-market/so_op_3705-dispatch-clean.pdf?la=en&hash=D1D681F4ED245D8DECFEC555DD3FE629
https://aemo.com.au/-/media/files/stakeholder_consultation/consultations/nem-consultations/2025/security-enablement-procedures/draft-security-enablement-procedures.pdf?la=en
https://aemo.com.au/-/media/files/electricity/nem/security_and_reliability/power_system_ops/procedures/so_op_3708-non-market-ancillary-services.pdf?la=en
https://aemo.com.au/-/media/files/electricity/nem/planning_and_forecasting/transition-planning/aemo-2024-transition-plan-for-system-security.pdf?la=en
https://aemo.com.au/-/media/files/electricity/nem/security_and_reliability/congestion-information/2021/constraint-formulation-guidelines.pdf?la=en
https://aemo.com.au/-/media/files/electricity/nem/security_and_reliability/power_system_ops/procedures/so_op_3718-outage-assessment.pdf?la=en&hash=CB561525DFE62EDD6627EF137C13833C
https://tech-specs.docs.public.aemo.com.au/Content/TSP_EMMSDM56_Nov2025/DM_v5.6_Nov25_Index.htm?tocpath=Electricity%20Data%C2%A0Model%7CDM%205.6%20-%20November%202025%7C_____0
https://tech-specs.docs.public.aemo.com.au/Content/TSP_EMMSDM56_Nov2025/DM_v5.6_Nov25_Index.htm?tocpath=Electricity%20Data%C2%A0Model%7CDM%205.6%20-%20November%202025%7C_____0

1.9 Approval to change

No approval or agreement to change required from participant change controllers. Agreement
was sought in the NEM Reform Wholesale Consultative Forum.

1.10 Market systems user group meetings

The Market Systems User Group (MSUG) is an industry user group established to discuss NEM
wholesale and retail IT systems releases. Its purpose is to facilitate the continuing improvement
of AEMO's IT systems by seeking feedback and collaboration from participants.

MSUG meetings are open to all interested parties, with invitations sent to all included on the
distribution list. If you have a technical question for a project and want to attend the MSUG ask
your company’s support team to include your email address in their AEMO Help Desk Bulletin
(CRM) distribution list.

1.11 Version numbers

AEMO releases new versions of this document as the technical requirements are
streamlined.

Incremental version numbers such as 1.01, 2.01 and so on mean there is a minor change to the
technical specification.

Major version numbers such as 1.00, 2.00 means there are substantial changes to the technical
specification. Participants must carefully review these changes, detailed below.

1.12 Changes in this version
The changes to this version include:
e Updates to Registration chapter.
e Adds more details to the Settlements reports section.
e Adds link to the data model technical specification in Electricity Data Model 5.6 chapter.
e Adds some mock screenshots in the Markets Portal section.
e Adds some details to the APIs chapter.

e Adds more details in the Reports chapter.

© AEMO 2025 | EMMS - Technical Specification - December 2025 9
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2 Proposed Timeline

The dates for the Market System User Group Meetings (MSUG) are tentative. We will provide
an invitation one week prior to the meeting.

Milestone Date Description

Approval required NA Final date for participant approval of this
Release

Revised Technical Specification May 2025 AEMO releases new versions of this document

as the technical requirements are streamlined.
During the project this document is the source
of truth

From the production release, the technical
specification becomes final and the related
documents become the source of truth

Technical Specification Portal

Related Documents publication

1 October 2025

Release of guides and resources mentioned in
Related on page 8

Next MSUG meeting

2 June 2025 (TBC)

Market Systems User Group Meeting (MSUG)
to review the technical specification and ask
AEMO technical SMEs questions

This date is tentative. The Knowledge
Management Team provides the invitation prior
to the meeting

Pre-production Data Model auto
subscription

24 September 2025

No auto-subscription for
existing files

For any existing files with modified or new
tables, if participants are subscribed, AEMO
moves them to the Legacy version

For more details, see Data subscription on
page 12

Pre-production Data Model
release

24 September 2025

Participant Data Model scripts released

Pre-production refresh

Wholesale
preproduction

18 August 2025 - 5
September 2025 (for
ISF 1.0)

Retail preproduction

25 August 2025 - 29
August 2025 (for MSR -
R1)

Refresh of the pre-production system with data
refreshed from the production system. An
outage of up to five days can occur to the pre-
production environment during this period.
Participant access is not restricted, however,
AEMO do not guarantee the pre-production
data content or system availability. During the
refresh, access to other AEMO systems such
as AWEFS, EMMS, OPDMS, and STTM may be
intermittently affected
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Milestone

Date

Description

Pre-production implementation

25 September 2025 - 2
October 2025

AEMO implements components of the Release
to pre-production for participant testing

AEMO has full access to the system during this
period

Participant access is not restricted; however,
the data content or system availability is not
guaranteed

Pre-production available

15 October 2025

Testing period begins for participants

Market Trials

1 October 2025 - 1
December 2025

AEMO coordinated testing with all participants

MSUG meeting: pre-production
review

1 November 2025 (TBC)

MSUG to review the technical specification and
ask AEMO technical SMEs questions

This date is tentative. The Knowledge
Management Team provides the invitation prior
to the meeting

Production implementation

24 November 2025 -1
December 2025

AEMO implements the release to production

Production Data Model auto
subscription

19 November 2025

No auto-subscription for
existing files

For any existing files with modified or new
tables, if participants are subscribed, AEMO
moves them to the Legacy version

For more details, see Data subscription on
page 12

Production Data Model release

19 November 2025

Participant Data Model scripts released

Production systems available

2 December 2025

Production systems available to participants

MSUG meeting: post-production
review

18 December 2025
(TBC)

Market systems user group meeting to review
the implementation of the production release

This date is tentative. The project manager will
provide an invitation one week prior to the
meeting

© AEMO 2025 | EMMS - Technical Specification - December 2025
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3 Participant Impact

This chapter is updated as the details are finalised during the project lifecycle.

For more information on the market trial, see the Draft Market Trial Strategy.

1.1 EMMS data model v5.6

Participants wanting to receive the ISF information in their Data Interchange environments
must upgrade to EMMS Data Model v5.6.

1.2 Data subscription

1.2.1 Auvuto-subscription

Existing participants are auto-subscribed to any new files when they upgrade to the latest data
model version. New file names to be advised.

1.2.2 Legacy files

There is no auto-subscription for the following existing files:
e TBC
Participants are moved to the Legacy version of this file and continue to receive the same data

until they upgrade to EMMS Data Model v5.6 and subscribe manually to <ADD FILEID here>.
Once you upgrade, unsubscribe from <ADD FILEID here>.

© AEMO 2025 | EMMS - Technical Specification - December 2025 12
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Improving Security Frameworks

4 Improving Security Frameworks

41 Goal

The Improving Security Frameworks (ISF) project aims to improve the market arrangements for
security services. The ISF project addresses system security challenges during the transition
by reducing reliance on directions and providing better incentives for participants to invest in
providing system security in the longer-term. It also increases transparency on system security
needs and understanding, and how AEMO plans to manage system security as we transition to
a secure net-zero emissions power system.

The ISF project allows AEMO to predict when a system shortfall is expected in the operational
timeframe and use the system security contracts to fill this gap using the new Security
Scheduler.

4.1.1 New service types

Service types impacted by the ISF project are called the system security services (SSS) and
include the following:

e System strength services - scheduled by Security scheduler
¢ Inertia network services - scheduled by Security scheduler
e Network Support and Control Ancillary Services (NSCAS)
e Transitional services (new)

- Type 1

— Type 2

Depending on the circumstance, AEMO or the Transmission Network Service Provider (TNSP)
procure these services under a contract for that service per the NER.

For more information on overview of ISF, see Improving security frameworks for the energy
transition HLIA.

4.2 High-level changes

Function Description Reference

Registration Minor updates to identify security service providers and associated units

© AEMO 2025 | EMMS - Technical Specification - December 2025 13
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Function Description

Reference

EMMS Data Model New/updated data model tables to support enablement instructions, ISF
v5.6 schedules and ISF reporting.

Settlements/Billing changes for NSCAS and NMAS security services
procured by AEMO

Settlements Updates to Settlement Reports

New ISF interface called the Security Service Management (SSM) in the
Markets Portal:

- To access and enablement instructions, indicative DUID schedules and
variable reporting

- To submit/maintain ISF service availability (and other operational
information).

Markets Portal

Adds new reports for the following:
- Rolling DUID Schedule

- Final Day + 1

- Enablement Instruction

- Enablement Periods Day + 1

- Enablement Costs Day + 1

- Schedule availability

Reports

© AEMO 2025 | EMMS - Technical Specification - December 2025
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5 Registration

The Registration team ensures all ISF providers providing security services:
e Have a DUID (registration data) including assets currently not formally registered with
AEMO, synchronous condensers or experimental assets.

e Have contract information (ISF services provided) and availability stored in (new) ISF
data store.

¢ Are predominantly registered scheduled load, generation, and bidirectional units.

¢ Non-registered providers have Participant IDs with the category System Security and the
class code as NON-MARKET.

Some scenarios:

e Market Participant with existing market PID (with categories Market Generator, System
Security) and existing classified DUID (Scheduled Generator) must have an existing
market DUID flagged for System Security linked to the market PID.

e Market Participant with existing market PID (with categories Market Generator, System
Security) and new unit not classified (Synchronous Condenser) but is required to provide
system security services must have a non-market DUID flagged for System Security
linked to a new station ID linked to the market PID.

¢ Non-market provider with a new non-market PID (with categories System Security) and
new unit not classified (Synchronous Condenser) but is required to provide system
security services must have a non-market DUID flagged for System Security linked to the
non-market System Security PID.

5.1 Updates to Registration systems

The ISF project add the following changes to the Registration systems:
e Adds a new participant category called SECURITYSERVICE.

e Adds a new connection point type called SECURITYSERVICE.

© AEMO 2025 | EMMS - Technical Specification - December 2025 15
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6 Settlements

For the New service types introduced in ISF, the following are the payment and recovery types.

6.1 Paymenttypes

The payment types describe the ways through which AEMO compensates a service provider
for the security service they provide.

Payment types Availability ($/hr) Compensates a provider for maintaining the availability of the
system security service.

Activation Only paid if not operational in time before instruction. Paid to
($/activation) come online for system security services.
Usage ($/hr) Payment for actual usage for when the unit was on for system

security service purposes as indicated by enablement start and
enablement end period in the scheduling tool.

Energy Revenue ($) Revenue transfer to AEMO from the sale of electricity on the
spot market (positive or negative) resulting from the ISF asset
enabled at Minimum Dispatch or Auxiliary Load (if applicable).

Test Payment for conducting successful tests.

Ad hoc Lump sum payment for service providers uploaded manually.

OTHER Payment Type allows extra fields for bespoke contracts in
future.

6.2 Recovery types

The recovery types are the mechanisms through which AEMO recovers the payments from the
market.

Recovery types Trading interval (TI) Single Tl payment recovered based on single Tl energy.
Settlement Day Each Tl payment recovered based on energy for settlement
day.
Billing Week Each Tl payment recovered based on energy for Billing week.
Event Duration Each Tl for event duration recovered based on the energy over
the event duration.
Ad hoc Recovery for event ad hoc/manual.

© AEMO 2025 | EMMS - Technical Specification - December 2025 16
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6.3 Settlement reports
Within Settlements, the ISF project updates the following reports:
e Settlement Reconciliation
e NMAS Recovery
e NMAS recovery RBF
e Ancillary Summary

These reports include new rows for the new services.

6.3.1 Settlement reconciliation report

The SR report contains new NMAS details:

e The service fields in the NMAS — Payments
section include the new service types for Inertia,
System strength, Type 1 and Type 2. details as these are finalised.

The design is in progress for this

change and AEMO provides more

HNon Market Ancillary Service Transactions - Payments

NMAS Type Service Provided Amount($)
SRAS RESTART $516,858.88
NSCAS SYSTEM STRENGTH $1,500.00
Type 1 MsL $2,300.00
Total Payment From AEMO $52@,658.88

e Adds a new section for ISF NMAS by contract/DUID to provide a payment summary at
Contract / DUID level. Each Payment type is listed as a row for each contract / DUID.

@lon Market Ancillary Service by Contract ID - Payments

Contract ID, Type & DUID 55 5T @1 NSCAS System Strength DUID1
Availability Payment $10ee
Usage Payment $500
Contract ID, Type & DUID T1_ 5T &1 Transitional Services Type 1 DUID3
Availability Payment 2000
Usage Payment $1ee

e The calculated recovery amounts for each type of payment is displayed against these
rows.
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Settlements

¢ Inthe NMAS Transactions by Region and Type - Recovery and NMAS payment by
contract ID and DUID, the following payment types are updated:

Availability

Activation

— Usage

Energy Revenue

Testing

6.3.2 NMAS recovery report

Updates the report with new NMAS details:

e Service — now includes new services for inertia, system strength, type 1, and type 2
transitional services.

e Payment type — updates with all payment types for ISF, availability, activation, energy
revenue, usage and test.

e Recovery amount — Calculated based on consumed and sent out energy.

6.3.3 NMAS recovery RBF report

Updates the report with new NMAS details:

e Service — now includes new services for inertia, system strength, type 1, and type 2
transitional services.

e Payment type — updates with all payment types for ISF, availability, activation, energy
revenue, usage and test.

e Recovery amount — Calculated based on consumed and sent out energy.

6.3.4 Ancillary summary report

Updates the report with new NMAS details:

e Service — now includes new services for inertia, system strength, type 1, and type 2
transitional services.

e Payment type — updates with all payment types for ISF, availability, activation, energy
revenue, usage and test.
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Electricity Data Model 5.6

7 Electricity Data Model 5.6

Participant systems incorrectly configured and not compliant with the Baseline

Assumptions in the Data Interchange Framework and Glossary may suffer data loss.

This Release contains an updated version of the Electricity Data Model 5.6. This section
describes the affected packages, tables, files, reports, and interfaces.

For more information on the changes, see EMMS Technical Specification — Data Model 5.6 —
November 2025.

© AEMO 2025 | EMMS - Technical Specification - December 2025 19


https://tech-specs.docs.public.aemo.com.au/Content/TSP_EMMSDM56_Nov2025/DM_v5.6_Nov25_Index.htm?tocpath=Electricity%20Data%C2%A0Model%7CDM%205.6%20-%20November%202025%7C_____0
https://tech-specs.docs.public.aemo.com.au/Content/TSP_EMMSDM56_Nov2025/DM_v5.6_Nov25_Index.htm?tocpath=Electricity%20Data%C2%A0Model%7CDM%205.6%20-%20November%202025%7C_____0

Markets Portal

8 Markets Portal

A new interface in the Markets Portal to allow system security service providers titled the
Security Service Management interface whether they are registered or non-registered
participants.

The security service providers can import file to update the parameters. They can also search,
filter and export data from the page.

The interface also generates missing data by performing a system check at regular intervals to
see if all relevant parameters are available for the next 7 prospective calendar days. If not, it
generated this data for those time intervals.

8.1 User access rights

To access the new interface within the Markets Portal, make sure you have the following user
rights entity:

<NEED INFO ABOUT USER RIGHTS to access the The design is in progress for this

interface> .
tehidee change and AEMO provides more

Participant Administrators (PAs) authorise Participant details as these are finalised.
User access in MSATS. The initial PA is set up by

the AEMO system administrator as part of the

registration process.

The PA needs to tick the following rights to allow access to the Security service management
interface in the Markets Portal:

Function Access rights

Read Allows user to only view relevant information.

Create/Update Allows user to edit asset availability.

Delete Allows user to delete asset availability
8.2 Security service management The final interface may be
interface different from the screenshots in

. , . . this section.
The interface allows security service providers to

perform the following:
e On the Asset Availability screen:
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Markets Portal

— View and update their unit’s availability parameters.

— View and update their unit’s operational parameters.

® 0 ) imctie Browser Tib -

&) Acive Tab x

‘E-QAEN\O Security Services Management App

= Menu 1Y Favourites
=X
@ Home
Asset availability

Edit availability
Reports

Enablement instructions

Pttps: e aemo. om0

Asset availabi

ility

NEM Clack: 23/10/2025, 4:00:00 AEST

Search for availability based on Availability dates and DUID. References to time are in Australian Eastern Standard Time.

Dispatchable unit identifier
DUID12345

Contract ID
~ 12321321,

4323243

Awailable from date

231072025

Aailzble to date
& 291062025

Framework type

8

Tope 1

Availability table Con

Available from  Available to

tract details  Availabil

231M0/2025 2971042025

Table displaying for:
23/10/2025

NEM day starts 3t 4:00 and ends at 3:59 the following day

lity chart

um enablement duration (mins}

3 Expand table

Variable unit count ]

1 400
2 405
3 410
4 415
5 420
6 425
7 430
] 435
9 2:40

Data type
2311012025 Explicit
231012025 Implicit
2311012025 Explicit
231012025 Implicit
2311012025 Explicit
21012025 Implicit
2311002025 Explicit
23110205 Implicit
2311012025 Explicit

muanmnae —

e On the Enablement Instructions screen:

G.)AEMO Security Services Management App

= Menu Yy Favourites
“ > X

@ Home

Asset availability
Reports

Enablement instructions

Historical enablement
instructions

Scheduled DUID
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T Clear filter

Action

v View
View
View
View
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> View
> View
> View
> View
> View

Transaction
D it}
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data

Initiating

Trans ID n
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Null
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data
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23/10/2025
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23/10/2025

23/10/2025

Created

Y

time.
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Equip
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564534534

34343

12346

2131414
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Status

Y

v
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data
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34343

12346

2131414

34535435
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45345345

Enabled
Units

7 Exp
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v

dispatch

and table

23/10/2025

23/10/2025

23/10/2025

23/10/2025

True

12:56

12:56

12:56
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Markets Portal

View the current provider’s enablement instructions and amendments.

Current and in progress enablement instructions under a tab called Current
enablement instructions.

View historical enablement details under the Historical enablement instructions.

Users can download all current and historic enablement instructions.

e On the Schedule screen:
— AEMO publishes the schedule information.

— Users can download all schedule information (current or historical) based on filtered
or unfiltered search.

e On the Reports screen:

im Home

Asset availability —
Edit availability
Reports +

Enablement instructions +

— Users can view and download current and historical reports.
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APIs

? APIs

For ISF, the following functionality are available using

APls: The API design is in progress and

e The APIs allow participants to submit, validate, and AEMO provides more details as
manage asset availability data for 7-day forecasts in
5-minute intervals. Participants can also perform
these functions using the Markets Portal or upload a
file in the Markets Portal interface.

these are finalised.

e The APIs allow provides to pull the enablement instructions relevant to their participant
ID.
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Reports

10 Reporis

The following new reports are going to be published to the participants as a part of the ISF
changes:

¢ Indicative rolling DUID schedule report The design is in progress for this

e Enablement instructions report change and AEMO provides more
o Final day + 1 report details as these are finalised.
e Enablement periods day + 1 report

e Enablement costs day + 1 report

e Scheduled availability report

10.1 Indicative rolling DUID schedule report

This report provides notice of system security status to service providers and TNSP. The intent
is to provide forewarning of possible enablement instruction that may be required.

Visibility: Private sent to relevant TNSP and service provider.

Details: The report contains the energy target for a region, DUID, start and end time, and the
security status.

Trigger: If the DUID status is any of the following — scheduled, instruction sent, fulfilment, or
fulfilment failed.

Schedule: Initially, every 30 minutes based on the results of the scheduler post processing.

This report is available in the Participant Data Model report as well as on the Markets Portal.

10.2 Enablement instructions report

An enablement instruction is a transaction that notifies a participant that their service will be
required. It can also be used as a means of informing the recipient there is a change to a
previous enablement instruction.

It contains information requesting a service provider to execute a security strength service.
Visibility: Private sent to relevant TNSP and service provider.

Trigger: When a scheduler detects a change to a previously sent enablement instructions.
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Reports

This report is available in the Participant Data Model report as well as on the Markets Portal.

10.3 Final day + 1 report

The Final Day + 1 report provides Participants with enablement information from the previous

day. The report only contains the last version of the enablement instructions.
Visibility: Private sent to relevant TNSP and service provider.

Details: The report contains information related to the previous day system security

enablement signals. It reflects the latest version of the enablement instruction/amendment and

provides the participants visibility of their latest settlement position.

Trigger: Daily at 4:00 am.

This report is available in the Participant Data Model report as well as on the Markets Portal.

10.4 Enablement periods day + 1 report

This report provides visibility of the previous days enablement’s at a DUID level.
Visibility: Public
Trigger: Daily at 4:00 am.

This report is available in NEMWeb as well as on the Wholesale Data Interchange.

10.5 Enablement costs day + 1 report

This report provides visibility of the previous days enablement’s estimated costs at a region
level.

Visibility: Public
Trigger: Daily at 4:00 am.

This report is available in NEMWeb as well as on the Wholesale Data Interchange.

10.6 Scheduled availability report

The Scheduled Availability Report provides Participants with the periods their assets were
available for use over the previous 7 days.

Visibility: Private to only TNSPs listed in the contract.
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Reports

Trigger: Weekly, every Monday at 4:00 am.

This report is available in the Participant Data Model report as well as on the Markets Portal.
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FAQs

11 FAQs

This section is updated based on the participant queries from the MSUG.
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Implementation

12 Implementation

12.1 Transition

TBC

12.2 Upgrading

You can upgrade your pre-production or production Data Model environments once you
receive the Data Model scripts. Applying the scripts sets up the new Data Model structure on
your local database. You receive the same data until the new versions of fields, files, and
reports are released into pre-production or production and you update your subscriptions.

For help, see:

e Upgrading your DI environments

e Updating your subscriptions:

12.3 Implications

To maintain systems in-line with AEMO’s market systems, participants need to:

¢ Review and assess the impact on their market systems with respect to the changes
implemented as part of this Release.

e Change their systems prior to the implementation of this Release.

e Schedule staff and resources to upgrade their market systems for the production
implementation of this Release.

12.4 Risks

e TBC
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Terms

13 Terms

13.1 Rules Terms

You can find the following terms defined in the National Electricity Rules (NER) and the
Settlements Residue Auction Rules.

Term Term Term

AEMO Maximum Units Trading Limit
AEMO Markets Portal NEM Trading Margin
AEMO Website Notional Interconnector Trading Position
Directional interconnector Region Unit Category
Linked Bid Regional reference prices Units

Market Clearing Price

Registered Participant

Market Participants

Trading Interval

13.2 Glossary

You can find a full list of AEMO glossary terms in Industry Terminology on AEMQO’s website.

Abbreviation/Term Explanation
AEST Australian Eastern Standard Time
Binding inertia The binding inertia sub-network allocation, binding satisfactory inertia level and binding

requirements

secure inertia level.

Binding system
strength requirements

The system strength standard specification (as defined in clause $5.1.14) as applicable
for each system strength node.

Contract The contract or agreement between the procurer and the provider for providing system
security services to be used under the mechanisms (e.g. enablement, settlement, etc.)
brought in by the ISF project.

EMMS Electricity Market Management System; software, hardware, network and related
processes to implement the wholesale energy market

FCAS frequency control ancillary services
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Abbreviation/Term

Explanation

FTP

File transfer protocol

Inertia service

The Inertia Service Provider for an inertia sub-network is:

provider

- the Transmission Network Service Provider for the inertia sub-network; or

- if there are more than one Transmission Network Service Provider for the inertia
sub-network, the jurisdictional planning body for the participating jurisdiction in
which the inertia sub-network is located.

Inertia sub-networks are currently split up by NEM region boundaries, so there is only

TNSP per region and therefore the inertia service provider for all inertia sub-networks

is the TNSP.

NOT a registration category.

ISF enabled A system security services unit provides a system security service in accordance with
AEMO’s instructions. A service commences enablement after the Activation Period
ends.

MSATS Market Settlement and Transfer Solution for retail electricity

NER National Electricity Rules

Network support An agreement under which a person agrees to provide one or more NSCASs to a

agreement Network Service Provider, including system strength or inertia services provided to
meet an NSCAS gap.

NMAS Non-Market Ancillary Service

NSCAS Network Support and Control Ancillary Service. A service (including an inertia network

service or system strength service) with the capability to control the active power or
reactive power flow into or out of a transmission network to address an NSCAS need.

NSCAS provider

A person who agrees to provide one or more NSCASs to AEMO under an ancillary
services agreement. NOT a registration category.

Mw Megawatt

PID Participant ID

Procurer Either AEMO or the TNSP. The parties procuring contracts from the system security
service provider.

Provider The parties entering system security contracts with the procurer to provide system

security services.

Initially, providers are Market Generators with Generators (Scheduled and Semi-
Scheduled) or Integrated Resource Providers with Battery Energy Storage Systems
(BESS). However, they may not always be a registered participant.
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Abbreviation/Term

Explanation

Power system security

Achieved when controls and services are available to keep the power system operating
within defined technical limits and capable of returning it within those limits after
credible disturbances. This differs from reliability which concerns the ability to supply
adequate power to satisfy consumer demand in accordance with defined standards.

Release

EMMS - Technical Specification - December 2025

Release Dates

Pre-production: Tuesday 30 September 2025

Production: Tuesday 2 December 2025

Synchronous machine

A synchronous generating unit or a synchronous condenser.

System security

Power system security relates to: the technical parameters of the power system such
as voltage and frequency. the rate at which these parameters might change. the ability
of the system to withstand faults.

Security Unit

Represented by a DUID, the asset providing the system security service per contract.

Spot market operation

Definition applicable in ISF info guide context only: a system security services unit
operating for the purpose of earning energy revenue and/or FCAS revenue.

SSS

System Security Services

Synchronous machine

A synchronous generating unit or a synchronous condenser.

Synchronous Three
Phase Fault Level

The three phase fault level comprising Synchronous Machines and those grid-forming
inverters whose positive system strength contribution has been demonstrated by wide-
area PSCAD/EMTDC studies, in MVA.

System security
service provider

Each of the following:

1. a System Strength Service Provider;
2. an Inertia Service Provider;

3. a NSCAS Provider; and

4. a Transitional Services Provider.

NOT a registration category.

System strength
service provider

The System Strength Service Provider for a region is the Transmission Network
Service Provider for the region. NOT a registration category.

TI

Trading interval

TBC

To be confirmed
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Abbreviation/Term

Explanation

TNSP

Transmission Network Service Provider. A person who engages in the activity of
owning, controlling or operating a transmission system. Must be a registered Network
Service Provider participant category with AEMO. Currently one TNSP per NEM region
as follows:

- NSW: TransGrid

- QLD: Powerlink

- SA: ElectraNet

- TAS: TasNetworks

- VIC: AEMO (VIC Planning — moving to VicGrid 2025)

Transition Plan for
System Security

A new annual report (Transition Plan) required by the ISF rule change, outlining a plan
to maintain power system security for the NEM through the transition to a low-
emissions power system.

Transitional services

A new framework defined by the ISF rule change, enabling AEMO to procure
transitional services necessary for the energy transition that cannot otherwise be
provided through existing frameworks (Type 1 contracts), and to trial new sources of
security services or new applications of existing technologies (Type 2 contracts),
expiring on 1 December 2039.

Transitional services
provider

A person (may be a registered or unregistered participant) who agrees to provide one
or more transitional services to AEMO under an ancillary services agreement. Only
procurable by AEMO, not TNSPs, but TNSPs can be a transitional services provider
(see service providers for more info). NOT a registration category.
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14 References

Guide to AEMO'’s e-Hub APIs: Provides details about using AEMO'’s e-Hub as an interface to
communicate information with AEMO. It assists Wholesale electricity and gas participants
developing their own APIs.

Guide to Information Systems: Provides guidance for Registered Participants and interested
parties about AEMO's participant electricity market systems.

Guide to User Rights Management: Assists participant administrators (PAs) to use the user
rights management functions in the MSATS Web Portal.

Retail Electricity Market Glossary and Framework: assist participants of the Retail Electricity
Market to understand the overall framework. It also contains a list of terms used in the
Retail Electricity Market Procedures and a full list of NEM procedures, guidelines, and
documents.

14.1 Data interchange and data model resources

14.1.1 About

Information about setting up a Data Interchange environment: Data Interchange Help > About
Data Interchange.

14.1.2 Help

o Data interchange online help

14.1.3 Software

You can find Data Interchange software in the following locations:

e Data Interchange Help > Software Releases.

¢ Releases directory on the participant file share: FTP to 146.178.211.2 > Data
Interchange, pdrBatcher, pdrLoader, or pdrMonitor.

14.1.4 Reporis

e Data Interchange Help > Data Model Reports.
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https://visualisations.aemo.com.au/aemo/di-help/Content/Data_Model/MMS_Data_Model.htm?TocPath=_____11

14.1.5 Releases

e Data Interchange Help > Release Documents.
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A1l. Version history

15.1 v0.01

No changes, this is the initial version.
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